# Table of Contents

- What is FCAWIN? ................................................................. 1
- Navigating the Facility Condition Analysis System ..................... 2
  - Selecting Items from Menus ........................................... 3
  - Using Command Buttons, Radio Buttons, & Check Boxes .......... 4
  - Selecting Items from Lists .......................................... 6
  - Entering Data Using Dialog Boxes ................................ 7
- Entering and Changing Data on Input Screens .......................... 8
- Selecting Data Using Selection Screens ................................ 10
- Preview Window .................................................................. 11
- Status Bar .......................................................................... 13
- File/Open ........................................................................... 14
- File/Close .......................................................................... 15
- File/Print Setup .................................................................. 16
- File/Exit ............................................................................ 18
- Edit .................................................................................. 20
  - Cut .............................................................................. 21
  - Copy ............................................................................. 22
  - Paste ............................................................................ 23
  - Delete ........................................................................... 24
  - Delete Row .................................................................... 25
  - Spelling ........................................................................ 26
- Module/Elevator/Entry ......................................................... 27
  - Elevator ....................................................................... 29
  - Operating Specs ......................................................... 30
  - Components .................................................................. 31
  - Projects ........................................................................ 33
  - Enter Project for Current Elevator ................................. 34
  - Update Project for Current Elevator ............................... 36
- Module/Elevator/Search ...................................................... 37
  - Conditionals ................................................................ 40
- Module/Elevator/Project Resequence ..................................... 41
- Module/Equipment/Entry .................................................... 42
  - Equipment ..................................................................... 44
  - Secondary Components ............................................... 46
- Related Procedures ............................................................ 47
What is FCAWIN?

The FCAWIN System is an interactive PC-based Windows-compatible facility condition analysis (FCA) system which, used in conjunction with an on-site analysis by ISES engineers and architects, enables you to develop or update a cost estimate for changes necessary to bring existing facilities up to all current codes and proper maintenance levels.

This system offers many features including the EEM (Engineering Economy Module), Elevator Module, Backlog Reduction (History), and Equipment Inventory module.
Navigating the Facility Condition Analysis System

Navigating the FCA System consists of:

- Moving between screen fields using the mouse or the keyboard
- Selecting items from menus
- Selecting functions and options using command buttons, radio buttons, and check boxes
- Selecting items from lists
- Entering data using dialog boxes
- Entering and changing data on input screens
- Selecting items from selection screens
- Scrolling and printing data from the print preview screen
- Monitoring the FCA System Status Bar

"Select" means to move the mouse pointer to an item such as a menu option and then to click (press) the left mouse button once. The selected item name is highlighted.

As a Windows application, the FCA System was designed to be used with a mouse. For that reason, navigational procedures are mostly described as mouse actions. However, where it is deemed useful, the keyboard action equivalent to the mouse action will be described.

Common keyboard functions specific to the FCA System are as follows:

- **Tab**: Activate the next field, function, or button
- **Esc**: Escape from a dialog box or menu
- **F7**: Check spelling

Key combinations are described in the following example:

**Shift + Tab**: Press and hold the Shift key while you press the Tab key.

You can use **Control + Insert** to copy selected text to the Windows Clipboard.

You can use **Shift + Insert** to paste text from the Windows Clipboard to a data entry field.

You can use **Shift + Tab** to activate the previous field, function, or button.

You can use **Control + D** to delete a row of data such as in a table. (The system will request a confirmation.)
Selecting Items from Menus

After you login, the FCA System window displays the titles of the available menus.

A menu is a list of functions which allow you to process the type of data specified in the menu title.

For example: The Building menu lists the functions available to enter and process building-related data.

To display a particular menu, click on the menu title.

To select the function you wish to execute from the menu, click on the function name.

Selecting a function from a menu executes the function or displays the function's submenu.

Another way you can display a particular menu is by holding down the Alt key and pressing the underlined letter in the menu’s title. This letter is referred to as the menu’s “hot key”. “Hot keys” can also be used to access menu options and data entry fields.

Another way you can select a menu option item from the displayed menu is to press the Up Arrow or Down Arrow key to highlight the desired option and then press the Enter key.
Using Command Buttons, Radio Buttons, & Check Boxes

A command button allows you to execute a particular function (such as saving data, verifying data, or canceling input) from the current window or dialog box.

The command button displays the name of the function it executes. The button is available if the function name is shown in bold. Otherwise the button is unavailable.

The following figure illustrates active and inactive command buttons.

![Select Equipment](image_url)

In this example, the View and Delete functions are unavailable until a list item is selected.

A radio button group is a list of value options for a field from which only one value can be selected at a time. Click on the radio button next to the value you wish to select.

The following figure illustrates the use of radio button groups.
A check box is used as a True/False indicator. If the check box is empty, the value is false. Click on the check box to check it or uncheck it.

The following figure illustrates the use of check boxes.
Selecting Items from Lists

The FCA System often uses tabs and windows which display lists of values from which an item may be selected.

To select such an item, click on the name of the item.

Another way you can select a list option item is to press the Up Arrow or Down Arrow key to highlight the desired item.

When the item has been selected, your next step depends on the current function. The documentation for each function describes how to proceed after selecting a list option item.
Entering Data Using Dialog Boxes

A dialog box allows you to enter information for a specific purpose such as assigning the name for a group. Dialog boxes are also used to confirm specific actions such as saving or deleting data.

To enter a data item using a dialog box:

1. Type the data into the dialog box field.
2. Press the Enter key or click on the OK button.
Entering and Changing Data on Input Screens

The FCA System uses input screens to enter and change database information.

Input screens such as windows and index tabs contain fields which hold the information as it is entered or changed. The field name (shown adjacent to the field) indicates the type of information you should enter.

When the input screen appears, the cursor should appear in the first field.

Note: If a different field or command button is active, Press the Tab key or Click in the first field (i.e. place the mouse pointer within the field and click the left mouse button)

To enter data for a field, type the desired data in the field and press the Tab key. This registers the data and activates the next available field.

To move to a particular field, click in the field.

If a Down Arrow symbol is shown next to a field (or within the field when it is selected), it means a pull-down list of preset values for the field is available.
To select a field value from a pull-down list:

1. Click on the Arrow symbol next to or within the field.
   The list of values displays.

2. Click on the desired value.
   The value displays in the field.

Press the Tab key to register the value.
If a scroll bar (Up and Down Arrow) is shown next to a field, it means the field accepts free form text information.

Information for the field is not restricted to the area shown. The scrolling arrows allow you to scroll through the text.
Selecting Data Using Selection Screens

A selection screen allows you to select one item of information for a specific purpose such as grouping data or determining which input screen to use.

To select an item using a selection screen:

1. Click on the desired item, or highlight the desired item by using the Up Arrow or Down Arrow key.

2. Click the OK button.

Note: Some selection screens use the View button or Load button instead of the OK button.
Preview Window

The toolbar at the bottom of the Preview window provides the following functions and information (from left to right):

1. Click on the Beginning of Document button to move to the first page of the report. If the report consists of only one page or if you are on the first page of the report, this function is disabled. On the keyboard, press Ctrl + Home.

2. Click on the Previous Page button to move to the previous page of the report. If the report consists of only one page or if you are on the first page of the report, this function is disabled. On the keyboard, press Ctrl + Page Down.

3. The page counter indicates which page of the report is currently displayed and how many pages the report contains.

4. Click on the Next Page button to move to the next page of the report. If the report consists of only one page or if you are on the last page of the report, this function is disabled. On the keyboard, press Ctrl + Page Up.

5. Click on the End of Document button to move to the last page of the report. If the report consists of only one page or if you are on the last page of the report, this function is disabled. On the keyboard, press Ctrl + End.

6. Click on the Cancel button to cancel the creation of the report. You should use this function only when creating the report is taking too much time.

7. Click on the Zoom icon to change the magnification of the report in the Preview window. The magnification choices are:
   - Enhanced: Largest magnification for easiest reading.
   - Actual: Print size of page.
   - Full: Full page reduced to fit within Preview window.

8. Click on the Print icon to send the report to the printer. The Print dialog box appears. Select the Print Range and number of Copies and click on the OK button. The Printing Preview information box appears indicating the print status.

9. Click on the Export icon to save the report as a disk file. You will be prompted to determine several file formatting features and to specify the destination filename and path.
10. Click on the Mail icon to send the report to an e-mail destination. You will be prompted to determine several file formatting features and to specify the e-mail destination address.

11. Click on the Close button to exit the Preview window for the current report.
Status Bar

The Status Bar at the bottom of the FCA System screen shows the status of the current function, the name of the current user and the name of the current database.

Ready  FCA_USER  FCA_U
File/Open

This function allows you to open a different FCA database.

When you select Open from the File menu, the Open FCA Database dialog box appears and displays the names of the FCA databases available.

To open an FCA database:
1. Select the database you wish to open.
2. When the Login dialog box appears, type your user name and press the Tab key. The default value for the User Name field is the name of the previous user.
3. Type your password and press the Enter key.

The previous database is closed automatically.

The Facility Condition Analysis System window appears and displays the name of the selected database in the lower right corner.
File/Close

This function allows you to close the current FCA database. It does not exit the FCA program.

When you select Close from the File menu, the name of the current database disappears from the bottom right corner of the Facility Condition Analysis System window.

Because no database is active, the FCA System window displays only the File menu title and the Help menu title.
File/Print Setup

This function allows you to select the printer, page orientation, and page size you wish to use to print FCA System reports.

Until you specify different printer settings, the FCA system uses the Windows default printer settings.

When you select Print Setup from the File menu, the Print Setup dialog box appears and displays the current FCA System printer settings.

To change printers:
1. Click on the radio button of the printer you wish to use.
2. If you chose Specific Printer, click on the Down Arrow next to the Printer Name field to list the printers available.
3. Click on the name of the printer you wish to use.
4. If you intend to make no other changes, click on the OK button.

To change the page orientation:
1. Click on the radio button of the desired page orientation.
2. If you intend to make no other changes, click on the OK button.

To change the paper:
1. Click on the Down Arrow key next to the Size field to list the paper sizes available for the selected printer.

2. Select the desired paper size.

3. Click on the Down Arrow key next to the Sources field to list the paper sources available for the selected printer.

4. Select the desired paper source.

5. If you intend to make no other changes, click on the OK button.

To review and/or use other options available for the selected printer, click on the Options button or the Network button (if you are connected to a network).
File/Exit

This function allows you to exit the FCA program.

When you select Exit from the File menu, the current FCA database is closed automatically and you are returned to the Windows Program Manager.
Edit

The following topics are available:
  Cut
  Copy
  Paste
  Delete
  Delete Row
  Spelling
Cut

Cut removes selected text characters and puts them on MS-Clipboard. This command is available only when you select text.

Text that you place on MS-Clipboard remains there until you replace it with a new item.
Copy

Copy places selected text characters on MS-Clipboard. This command is available only when you select text. Press Control + Insert to execute the Copy command from the keyboard.

Text that you place on MS-Clipboard remains there until you replace it with a new item.
Paste

Paste inserts a copy of the contents of MS-Clipboard at the insertion point. If any text is selected, it is replaced by the contents of MS-Clipboard. Press Shift + Insert to execute the Paste command from the keyboard.

This command is not available if MS-Clipboard is empty or if the selected text cannot be replaced.
Delete

Delete removes any selected text. Press the Delete key to execute the Delete command from the keyboard.

This command is not available if no text has been selected.
Delete Row

Delete Row removes the data from an entire row of a grid. (A grid contains data in columns and rows.)

Place the cursor in the row you wish to remove and select Delete Row from the Edit menu or press Control + D on the keyboard. A dialog box will prompt you to confirm the row deletion.
Spelling

Spelling checks the spelling in the active field. If a misspelled or unrecognized word is found, the Spelling Check dialog box appears.

Spelling Check dialog box options:

Not in Dictionary:
Displays a word not found in the main dictionary or open custom dictionaries.

Suggestions:
Lists suggested replacement words from the main dictionary.

Ignore:
Does not correct the spelling of the word in the Not in Dictionary box.

Ignore All:
Leaves the word in the Not in Dictionary box unchanged during all spelling checks in the current session.

Change:
Changes the word in the Not in Dictionary box to the word in the Change To box. If the Change To box is empty, this option is not available.

Change All:
Changes the word in the Not in Dictionary box to the word in the Change To box for all instances in the field. If the Change To box is empty, this option is not available.

Add:
Adds the word in the Not in Dictionary box to the dictionary.

Cancel:
Closes the Spelling Check dialog box but does not reverse any changes you have made.
Module/Elevator/Entry

This function allows you to view and enter elevator information.

Note: To enter elevator information, your security level must be User or higher. If your security level is Guest, you will only be able to view elevator data.

ISES (probably) entered your current elevator information and elevator-related projects during the FCA System installation. ISES will also (probably) enter information about any new elevators you acquire.

You will use this function mostly to view elevator information and to add projects for existing elevators.

To view or enter elevator information:

1. Select Elevator from the Module menu.
   The Elevator menu appears.

2. Select Entry from the Elevator menu.
   The Select Building dialog box appears and lists the buildings included in the database. To list the buildings by building name, click on the Sort By: Building Name radio button.
3. Select the building which holds the elevator for which you wish to enter information. The Select Elevator dialog box appears and lists the elevators entered for the specified building.

![Select Elevator]

Note: To delete the information for a particular elevator, select the elevator and click on the Delete button. The information is removed from the database. If it is needed later, it must be reentered.

If your level of security does not allow you to delete elevator data, the Delete button will not be active.

4. Select the elevator for which you wish to view or enter information and click on the View button.

or

Click on the New button to enter information for a new elevator.

The Elevator Entry window appears.

Elevator information is entered using the following tabs:
  - Elevator
  - Operating Specs
  - Components
  - Projects

Click on the tab for which you wish to view or enter elevator information.

The data entry source for the Elevator Entry window is the field measure data taken for the elevator.

5. To save the elevator information to the FCA database, click on the Save button. The Elevator Entry window will continue to display.

6. To discard changes to the elevator information, click on the Cancel button. The Select Elevator screen will reappear.
Elevator

The Elevator tab allows you to enter elevator duty and other general information about a new or selected elevator.

![Elevator Entry - [C-01]](image)

Car Number is the only required field on this tab.

Select the values for the following fields from the lists provided:
- Contractor
- Machine Type
- Hoistway Str (Structure)
- Door Type

Capacity is entered as pounds.

Design speed is entered as feet per minute.
Operating Specs

The Operating Specs tab allows you to enter information about the elevator's operating conditions and door measurements.

![Elevator Entry - [C-01]](image)

This tab contains no required fields.

You will be prompted to enter time and thrust information for Door 2 only if you selected the 2 Door radio button on the Elevator tab.

Speed values -- including OFR (One Floor Run) -- are entered as feet per minute.

Time values are entered as seconds.

Thrust is entered as pounds.
Components

The Components tab allows you to indicate which components are installed on the current elevator.

The Installed list will be blank if you are entering information for a new elevator.

The Available section lists the elevator components which can be added to the Installed list.

To add all the components in the Available list to the installed list, click on the button displaying the double left-pointing arrows (<<). The components will be displayed in the Installed list.

To add a particular component in the Available list to the Installed list:
1. Click on the component in the Available list you wish to add to the Installed list.

2. Click on the button displaying the single left-pointing arrow (<). The component selected will be displayed in the Installed list.

To delete all components from the Installed list, click on the button displaying the double right-pointing arrows (>>). The Installed section becomes blank.
To delete one or more particular components from the Installed list:

1. Click on the component in the Installed list you wish to delete.
   Press the Control key and click on any additional components in the Installed list you wish to delete.

2. Click on the button displaying the single right-pointing arrow (>).
   The component selected disappears from the Installed list.

To delete a range of components from the Installed list:

1. Click on the first component of the range in the Installed list you wish to delete.
   Press the Shift key and click on the last component of the range you wish to delete.

### Elevator Entry - (C-05)

<table>
<thead>
<tr>
<th>Elevator</th>
<th>Operating Spec</th>
<th>Components</th>
<th>Projects</th>
</tr>
</thead>
<tbody>
<tr>
<td>M-01</td>
<td>Machine C-02</td>
<td>Lighting</td>
<td></td>
</tr>
<tr>
<td>M-02</td>
<td>Worm Gear-03</td>
<td>Floor</td>
<td></td>
</tr>
<tr>
<td>M-03</td>
<td>Thrust C-04</td>
<td>Gate-Door</td>
<td></td>
</tr>
<tr>
<td>M-04</td>
<td>Brake C-05</td>
<td>Car Opers</td>
<td></td>
</tr>
<tr>
<td>M-05</td>
<td>Motors C-06</td>
<td>Safeties</td>
<td></td>
</tr>
<tr>
<td>M-06</td>
<td>Shaives C-07</td>
<td>Safety Shv</td>
<td></td>
</tr>
<tr>
<td>M-07</td>
<td>Generator C-11</td>
<td>Car Top</td>
<td></td>
</tr>
<tr>
<td>M-08</td>
<td>Controller C-12</td>
<td>Door Op</td>
<td></td>
</tr>
<tr>
<td>M-09</td>
<td>Selector C-13</td>
<td>Stop Switc</td>
<td></td>
</tr>
<tr>
<td>M-10</td>
<td>Governor C-14</td>
<td>Car Frame</td>
<td></td>
</tr>
<tr>
<td>M-13</td>
<td>Oil C-15</td>
<td>Car Guide</td>
<td></td>
</tr>
<tr>
<td>M-14</td>
<td>Access C-17</td>
<td>Phone</td>
<td></td>
</tr>
<tr>
<td>M-15</td>
<td>Lighting C-18</td>
<td>Ventilation</td>
<td></td>
</tr>
<tr>
<td>M-16</td>
<td>VentilationP-01</td>
<td>Buffer(s)</td>
<td></td>
</tr>
<tr>
<td>M-17</td>
<td>Floor P-02</td>
<td>Guards</td>
<td></td>
</tr>
<tr>
<td>F-02</td>
<td>Position F-03</td>
<td>Tail Sheav</td>
<td></td>
</tr>
<tr>
<td>F-03</td>
<td>Hall ButtoF-05</td>
<td>Floor</td>
<td></td>
</tr>
<tr>
<td>C-01</td>
<td>Position F-06</td>
<td>Lighting</td>
<td></td>
</tr>
</tbody>
</table>

2. Click on the button displaying the single right-pointing arrow (>).
   The range of components specified disappears from the Installed list.
Projects

The Projects tab allows you to update a project or add a project related to the current elevator.

Such projects specify elevator maintenance needs.

The Projects list will be blank if you are entering information for a new elevator.

Note: You must save the data entered using the Elevator tab before you can enter project data for a new elevator.
Enter Project for Current Elevator

To enter a new elevator project:
1. Click in the Component field of the first blank project line.

---

**Note:** When entering a new elevator project, the following fields are required:
- Component
- Liability
- Priority Class
- Project Class
- Action

2. Select the elevator component related to the project you wish to add. The value for the Category field is provided automatically.

---

### Elevator Entry - [C-01]

<table>
<thead>
<tr>
<th>Project</th>
<th>Category</th>
<th>Component</th>
<th>Description</th>
<th>Cost</th>
<th>Notes</th>
<th>Date Archived</th>
</tr>
</thead>
<tbody>
<tr>
<td>001VT030</td>
<td>V11A</td>
<td>M-10</td>
<td>Governor activation rope is slack</td>
<td>385.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>001VT031</td>
<td>V13A</td>
<td>M-10</td>
<td>Last test 1/20/95</td>
<td>0.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>001VT032</td>
<td>V11A</td>
<td>M-17</td>
<td>Clean floor of all carbon dust</td>
<td>400.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>001VT033</td>
<td>V13A</td>
<td>H-04</td>
<td>Replace missing tie tab gib at 4th floor</td>
<td>110.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>001VT034</td>
<td>V13A</td>
<td>H-10</td>
<td>Adjust all cable/rope terminations</td>
<td>752.00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
3. Select a value for each of the Liability, Priority Class, and Project Class fields.
Liability indicates whether the elevator owner or contractor is responsible for performing the project.

Priority 1 indicates that action is needed to avoid immediate danger.
Priority 2 indicates that action is needed to avoid potential danger.
Priority 3 indicates that action is necessary but not critical.
Priority 4 indicates no priority.

Project Class indicates the type of maintenance necessary.

4. Select the Action related to the project.
The values for the Description and Cost fields are provided automatically.

5. Click on the Save button.
or
Press the Tab key until the cursor is located on the next line.
The Project # is provided automatically. It indicates the building number and the elevator project sequence number.
3. In the third Available Criteria field, enter or select the value to compare to the subject using the specified condition for the current query criteria line. For example: 0

4. Click on the Add button to add the new Available Criteria line to the Current Search Criteria.

5. Repeat steps 1,2,3, and 4 until you have built the query you want.

6. Click on the Show Columns button to list the elevator data fields.

7. Click on each field you wish to include in the Query Results. If you selected a field by mistake, click on the field again to deselect it. The elevator ID and Car Number fields are included automatically as the first two fields in the Query Results.

8. Click on the OK button.

9. Click on the Query button. All elevator records matching the specified criteria are listed in the Query Results area. The columns can be resized by dragging the header margins.
10. Click on the Print button to display a report preview window. (See Reports section.)

To sort the results of the query:
1. Click on the title of the column by which you wish to sort the results.

2. Click on the Sort Results button.

To view or update the information for an elevator located by the query:
1. Select the elevator from the Query Results list.

2. Click on the Details button.
The Elevator Entry dialog box appears.
Conditionals

Equal To -- Record selected if value in specified subject field is equal to value entered in comparison field.

Not Equal To -- Record selected if value in specified subject field is not equal to value entered in comparison field.

Less Than -- Record selected if value in specified subject field is less than value entered in comparison field.

Greater Than -- Record selected if value in specified subject field is greater than value entered in comparison field.

Between -- Record selected if value in specified subject field equals or falls between either of the values entered in comparison field.

Starts With -- Record selected if value in specified subject field starts with value entered in comparison field.
You can expand the search by using the wild card ("*") in the value of the comparison field.

Like -- Record selected if any part of value in specified subject field matches value entered in comparison field.
You can expand the search by using the wild card ("*") in the value of the comparison field.
Module/Elevator/Project Resequence

This function allows you to resequence (prioritize) elevator-related projects. The purpose of prioritizing is to determine the order in which projects should be completed.

Note: To resequence elevator projects, your security level must be Admin or higher. If your security level does not allow you to resequence projects, the Resequence option will not be active.

Resequecing should not be performed until all the elevator projects for a building have been entered.

Project priority is determined internally by the FCA System and is based on the data entered for each elevator project. You can enter a priority value to override the value determined.

To resequence elevator-related projects:
1. Select Elevator from the Module menu. The Elevator menu appears.
2. Select Project Resequence from the Elevator menu. Resequecing is implemented automatically for all buildings. As resequencing occurs, a progress message displays in the status bar of the FCA System window. For example: Resequencing Projects for Building 001
Module/Equipment/Entry

This function allows you to view and enter equipment information.

Note: To enter equipment information, your security level must be User or higher. If your security level is Guest, you will only be able to view equipment data.

To view or enter equipment information:

1. Select Equipment from the Module menu.
   The Equipment menu appears.

2. Select Entry from the Equipment menu.
   The Select Building dialog box appears and lists the buildings included in the database.
   To list the buildings by building name, click on the Sort By: Building Name radio button.
3. Select the building which holds the equipment for which you wish to enter information. The Select Equipment dialog box appears and lists the equipment entered for the specified building.

![Select Equipment](image)

Note: To delete the information for a particular item of equipment, select the item and click on the Delete button. The information is permanently removed from the database. If it is needed later, it must be reentered.

If your level of security does not allow you to delete equipment data, the Delete button will not be active.

4. Select the item of equipment for which you wish to view or enter information and click on the View button.
   or
   Click on the New button to enter information for a new equipment item.

The Equipment Inventory window appears.

Equipment information is entered using the following tabs:
   Equipment
   Secondary Components
   Related Procedures

Click on the tab for which you wish to view or enter equipment information. The data source for the Equipment Inventory window is the faceplate of the equipment item and/or the invoice related to the equipment item.

5. To save the equipment information to the FCA database, click on the Save button.
Equipment

The Equipment tab allows you to enter general information about a new or selected item of equipment.

The following are required fields:
- Component Class
- ISES Identifier
- Inspection Date
- Floor

Select the values for the following fields from the lists provided:
- Component Class
- Unit
- Floor

If you have assigned a unique identifier to the equipment item, enter that identifier in both the ISES Identifier and Client Identifier fields. Otherwise, enter the combination of the building number and inspection sequence number (from the inspection notes) as the ISES identifier.

Unit is the unit of measure related to the value entered for Capacity.

For example: Capacity: 10000     Unit: BTU

Priority indicates the relative criticality of the equipment item.
In Service Date indicates the installation date and can be used to track the age of the equipment item.

To specify Utility Types, click on the check box of each utility type the equipment item uses.

You can use the Details section to enter other information about the equipment item.
Secondary Components

The Secondary Components tab allows you to enter information about the separate parts used by the equipment item. Examples include: Electric Motor, Control Panel, Transformer, Cylinder Block.

Select the CompClass (Component Class) value from the list provided.

Press the Tab key to move to the next field on the Secondary Components tab. Press Shift + Tab to move to the previous field.

You can also use the Horizontal Scroll Bar to access the fields located to the right or left of the fields displayed.

The columns can be resized by “dragging” the header margins.
Related Procedures

The Related Procedures tab lists the maintenance procedures related to the specified equipment item. The information on this tab is for viewing only.

To view the details of a particular maintenance procedure:
1. Select the procedure whose details you wish to view.
2. Click on the Details button.
   The Maintenance Procedure Entry window for the specified procedure appears. The information is view only.

Maintenance procedures are entered using the Maintenance Procedures function of the Module menu.
Module/Equipment/Search

This function allows you to query the FCA database to locate one or more equipment item records by the criteria you specify.

Note: You can perform a query regardless of your security level.

When you select Equipment from the Module menu, the Equipment menu appears.

Select Search from the Equipment menu.
The Query Equipment dialog box appears and lists the Current Search Criteria (if any).

Note: To delete all the lines of the Current Search Criteria, click on the Clear All button.
To delete a particular line of search criteria, select the line and then click on the Delete button.

To perform a query:
1. In the first Available Criteria field (from the list of equipment data entry fields), select the type of information you wish to use as the subject of the current query criteria line.
   For example: Serial Number

   ![Query Equipment dialog box]

2. In the second Available Criteria field, select the condition for the current query criteria line.
   For example: Greater Than

   Note: If you select as the query subject a field that has look-up values (such as Component Class), you must select Equal To or Not Equal To as the query condition.
3. In the third Available Criteria field, enter or select the value to compare to the subject using the specified condition for the current query criteria line. For example: 0

4. Click on the Add button to add the new Available Criteria line to the Current Search Criteria.

5. Repeat steps 1, 2, 3, and 4 until you have built the query you want.

6. Click on the Show Columns button to list the equipment data fields.

7. Click on each field you wish to include in the Query Results. If you selected a field by mistake, click on the field again to deselect it. The equipment ID and ISES Identifier fields are included automatically as the first two fields in the Query Results.

8. Click on the OK button.

9. Click on the Query button. All equipment item records matching the specified criteria will be listed in the Query Results area. The columns can be resized by "dragging" the header margins.
10. Click on the Print button to display the report preview window. (See Reports section.)

To sort the results of the query:
1. Click on the title of the column by which you wish to sort the results.

2. Click on the Sort Results button.

To view or update the information for an item of equipment located by the query:
1. Select the equipment item from the Query Results list.

2. Click on the Details button.
   The Equipment Inventory dialog box appears.
**Conditionals**

Equal To -- Record selected if value in specified subject field is equal to value entered in comparison field.

Not Equal To -- Record selected if value in specified subject field is not equal to value entered in comparison field.

Less Than -- Record selected if value in specified subject field is less than value entered in comparison field.

Greater Than -- Record selected if value in specified subject field is greater than value entered in comparison field.

Between -- Record selected if value in specified subject field equals or falls between either of the values entered in comparison field.

Starts With -- Record selected if value in specified subject field starts with value entered in comparison field.
You can expand the search by using the wild card ("**") in the value of the comparison field.

Like -- Record selected if any part of value in specified subject field matches value entered in comparison field.
You can expand the search by using the wild card ("**") in the value of the comparison field.
Module/Maintenance Procedures

This function allows you to view or enter equipment maintenance procedures and maintenance-related information.

Maintenance procedure information is entered for a specific component class of equipment and for each periodic maintenance routine.

Note: To enter maintenance procedure data, your security level must be Admin or higher. If your security level is User or Guest, you will only be able to view this data.

To view or enter a maintenance procedure:

1. Select Maintenance Procedures from the Module menu.
   The Select Procedure dialog box appears and lists the maintenance procedures included in the database.

   ![Select Procedure Window]

   Note: To delete a particular procedure, select the procedure and click on the Delete button. The procedure is permanently removed from the database. If it is needed later, it must be reentered.

   If your level of security does not allow you to delete maintenance procedures, the Delete button will not be active.

2. Select the maintenance procedure for which you wish to view or edit information and click on the View button.
   or
   Click on the New button to enter a new maintenance procedure.

   The Maintenance Procedure Entry window appears.
Maintenance Procedure Entry Window

Information for this window is based on the Means Operations and Maintenance Estimating Guide. As you enter the information, you can modify it to match local conditions if necessary.

The following are required fields:
Component Class
Frequency
Labor Cost: Code
Labor Cost: Hours
Material Cost
Procedure Steps

Select the values for the following fields from the lists provided:
Component Class
Labor Cost: Code
Frequency

Note: The maintenance procedures that coincide are combined. The following Frequency values are used:
Annual -- once per year
Semi-Annual -- once additionally per year
Quarterly--twice additionally per year
Monthly -- eight times additionally per year
Weekly -- forty times additionally per year
When you select the Code for an item in the Labor Cost section, the values for the Description and Rate fields are provided automatically. After you enter the value for the Hours field, press Tab.

Click on the Contractor Mark-up check box to include this value in the total procedure cost.

Click on the Save button to update the procedure information in the database.
Utility/Customize

This function allows you to customize the Facility Condition Analysis System to best suit your operating environment.

Note: To customize the FCA System, your security level must be Admin or higher. If your security level is User or Guest, you will only be able to view this data.

Most of your customize-related information is established during your FCA System installation.

When you select Customize from the Utility menu, the Application Customization window appears.

Customizing data is entered using the following tabs:
- Mark-ups
- FCA Definitions
- Reports
- Elevator Component
- Look-Up Tables
- Category Codes
- Building Standards
- Application Data
Mark-ups

The Mark-ups tab allows you to specify Global Markup Indexes, Project Cutoff Ranges, and Inflation Adjustment Factors.

Local price index information is taken from the Means Operations and Maintenance Estimating Guide.

Sister Component Damage refers to the damage to one component caused by the deterioration of a neighboring component.

Project Cutoff Ranges control the cost divisions used for reporting. After you enter or modify a range value, press the Tab key.

Inflation Adjustment Factors for previous years are entered by ISES when an update survey is performed.

Click on the Save button to keep this information in the database.
FCA Definitions

The FCA Definitions tab displays the Definitions section of the FCA survey report you received from ISES prior to the installation of the FCA System.

You can modify this information if necessary.

If you do, click on the Save button to update this information in the database.
Reports

The Reports tab allows you to map the reports available to your FCA System. The reports mapping table will usually be updated by ISES.

![Application Customization](image)

To add a report to one of the report select lists accessed from the Reports menu:

1. Click in the Section field of the first blank line.

2. Enter the Section number for the report.
   The Section number determines the order in which a group of reports will be generated.

3. Enter the name of the report.

4. Enter the system filename of the report.

5. If the report will be run for individual buildings, select Y as the Building value.

6. If the report will be run for individual projects, select Y as the Project value.

7. Enter the Building Parameter and/or the Project Parameter field used by the report.

8. Enter the Category for the report.
   The Category determines which Report menu item will include the specified report.

9. Click on the Save button to update this information in the database.
Elevator Components

The Elevator Components tab allows you to define the Elevator Component Codes and the Elevator Actions for each component code in your FCA System. This information is used to define elevator-related projects.

To add an elevator component code:
1. Click in the Component field of the first blank line of the code section.
2. Enter the Component Code and press the Tab key.
3. Enter the code Description and press the Tab key.
4. Enter the Category Code and press the Tab key. A new blank line will appear.

To add an elevator action for an elevator component code:
1. Click in any field of the elevator component code for which you wish to add an action.
2. Click in the Action field of the first blank line of the actions section.
3. Enter the action identifier and press the Tab key.

4. Enter the action description and press the Tab key.

5. Enter the action cost and press the Tab key. A new blank line will appear.

Click on the Save button to update the elevator component information in the database.
Look-Up Tables

The Look-Up Tables tab allows you to update the FCA System look-up tables.

You can add elements to existing tables but you cannot define new tables with this function.

To add an element to a look-up table:
1. Select the table you wish to modify from the Table Name list.
2. Click in the first field of the first blank line.
3. Enter the value for each table field and press the Tab key. A new blank line will appear.

Click on the Save button to update this information in the database.
Category Codes

The Category Codes tab allows you to update the Category Codes, Assessment Codes, and Assessment Categories in your FCA System.

This information is used to classify building-related projects.

The Component list depends on the System selected; the Element list depends on the Components list selected.

To add a system code:
1. Click on the System: Code field of the first blank line.
2. Enter the new system code and press the Tab key.
3. Enter the sort number for the new system code and press the Tab key.
4. Enter the description for the new system code and press the Tab key. A new blank line will appear.

To add a component code:
1. Click in any field of the system code for which you wish to add a component code.

2. Click on the Component: Code field of the first blank line.

3. Enter the new component code and press the Tab key.

4. Enter the description for the new component code and press the Tab key. A new blank line will appear.

To add an element code:

1. Click in any field of the component code for which you wish to add an element code.

2. Click on the Element: Code field of the first blank line.

3. Enter the new element code and press the Tab key.

4. Enter the description for the new element code and press the Tab key. A new blank line will appear.

You can use the Assessment Code table and the Assessment Categories table to link your own project classifying codes to the ISES codes used in the FCA System.

To link one of your codes to an FCA System code:

1. Click in the Code field of the first blank line in the Assessment Code section.

2. Enter your code and press the Tab key.

3. Enter the code description and press the Tab key.

4. Select the matching FCA System category code from the code list in the Assessment Categories section.

Click on the Save button to update this information in the database.
Building Standards

The Building Standards tab allows you to activate and deactivate building standards in your FCA System as needed for your operating environment.

Use the Look-Up Tables tab to add a new building standard to the Standards table.

To activate an inactive building standard:
1. Select each standard you wish to activate from the list of Inactive Building Standards. If you selected a standard by mistake, click on the standard again to deselect it.
2. Click the Activate button.
   Each specified building standard is added to the Active Building Standards list and removed from the Inactive Building Standards list.

To deactivate an active building standard:
1. Select each standard you wish to deactivate from the list of Active Building Standards. If you selected a standard by mistake, click on the standard again to deselect it.
2. Click the Deactivate button. Each specified building standard is added to the Inactive Building Standards list and removed from the Active Building Standards list.

Click on the Save button to update this information in the database.
Application Data

The Application Data tab allows you to update Database Information, specify links to External Applications and specify the Directory Paths for FCA System data input and output.

If AutoCAD is linked to the FCA System, you should enter the appropriate DDE and CAD command information.

If Word for Windows is available, you should enter the Word execution command and the command path. Word for Windows, when available, is used to enter the Building Summary.

To specify a Directory Path:
1. Type the path name into the selected path field.
   or
   Highlight the proper directory using the Available Directories browse feature and click on the pointer button (<<) of the selected path field.

Click on the Save button to update this information in the database.
Utility/Change Password

This function allows you to change your password.

To change your password:
1. Select Change Password from the Utility menu.
   The Change Password dialog box appears.

   ![Change Password Dialog Box]

   - **Old Password:** [Blank]
   - **New Password:** [Blank]
   - **Verify New Password:** [Blank]

2. Type your current password into the Old Password field. For security reasons your password does not display as you type it.

3. Type your new password into the New Password field.

4. Type your new password into the Verify New Password field.

5. Click on the OK button. An information box appears to indicate that your password has been updated. Click on the OK button to continue.

   **Note:** If you misspelled your old password, an error message displays. Click on the OK button to try again.

   If you misspelled your new password in the Verify New Password field, an error message displays. Click on the OK button to try again.

   You can use the mouse or the Tab key to move from field to field.

68
Utility/Security

This function allows you to view and update the list of FCA System guests, users, and administrators, and to reset the password of any person listed to the person’s User Name.

Note: To access the Security function, your security level must be Superadmin.

To reset a password:
1. Select Security from the Utility menu.
   The System Security dialog box appears.
2. Click on the User Name field of the person whose password you wish to reset.
3. Click on the Clear Password button.
4. When the Changing User Password dialog box appears, click on the Yes button.
Building/Building Management

This function allows you to view and enter general information about each building in the FCA System database.

Note: To enter building management information, your security level must be Admin or higher. If your security level is User or Guest, you will only be able to view this data.

To view or enter building management information:

1. Select Building Management from the Building menu.
   The Select Building dialog box appears. To list the buildings by building name, click on the Sort By: Building Name radio button.

   ![Select Building dialog box]

   Note: To delete the information for a particular building, select the building and click on the Delete button. The information is permanently removed from the database. If it is needed later, it must be reentered.

   Do not delete a building if one or more projects exist for the building.

   If your level of security does not allow you to delete building data, the Delete button will not be active.

2. Select the building for which you wish to view or edit information and click on the OK button.
   or
   Click on the New button to enter information for a new building.

   The Building Management window appears.
Building Management Window

Information for this window is taken from the field data collected for the building.

The following are required fields:
- Building Code
- Building Name
- Campus
- Survey Date
- FRC (Facility Replacement Cost)
- Square Feet

Select the values for the following fields from the lists provided:
- Campus
- Facility Type

The photo ID is a building-specific number that appears on databack-imprinted photos.

To enter floors:
1. Click on the first blank line of the Floors section.
2. Enter the floor number and press the Tab key.
3. Enter the number of the next floor and press the Tab key. Repeat this step until all the floors have been entered (including basements and tunnels).

Note: The last line of the Floors section must be a blank line.

Click on the Save button to update the building's information in the database.
Building/Summary

This function allows you to view and edit the summary information collected for each building during the ISES survey.

It is available only if your system contains the Word for Windows program and if this program has been linked to the FCA System using the Customize function.

When you select Summary from the Building menu, you will access the Word for Windows program directly.
Building\Profile\Architectural

This function allows you to view or enter the architectural profile of a specified building.

Note: To enter profile information, your security level must be User or higher. If your security level is Guest, you will be only be able to view profile data.

Most of the information in your architectural profile - if applicable - was established during your FCA System installation.

To view or enter architectural profile information:

1. Select Profile from the Building menu.
   The Profile menu appears.

2. Select Architectural from the Profile menu.
   The Select Building dialog box appears and lists the buildings included in the database.
   To list the buildings by building name, click on the Sort By: Building Name radio button.

3. Select the building for which you wish to view or enter architectural profile information.
   The Architectural Profile window for the specified building appears.

Architectural profile information is entered using the following tabs:

- General
- Structural
- Roofing
- Floors
- Fire Protection
- Parking
Miscellaneous
Handicap

Click on the tab for which you wish to enter or view information.
Click on the Save button to update this information in the database.
General

The General tab allows you to enter general architectural information about the specified building.

If a Down Arrow appears in the field in which you wish to enter information, click on the Down Arrow and then click on the desired value from those listed.

After you type or select the desired value for each field, press the Tab key.
Structural

The Structural tab allows you to enter structural information about the specified building.

If a Down Arrow appears in the field in which you wish to enter information, click on the Down Arrow and then click on the desired value from those listed.

After you type or select the desired value for each field, press the Tab key.
Roofing

The Roofing tab allows you to enter roofing information about the specified building.

<table>
<thead>
<tr>
<th>Type of Roofing</th>
<th>Built up</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roof Area (square feet)</td>
<td>44,000</td>
</tr>
<tr>
<td>Color (light, dark)</td>
<td>Light</td>
</tr>
</tbody>
</table>

After you type the desired value for each field, press the Tab key.
Floors

The Floors tab allows you to enter information about the floors of the specified building.

After you type the desired value for each field, press the Tab key.
Fire Protection

The Fire Protection tab allows you to enter information about the fire protection capabilities of the specified building.

![Fire Protection Table]

If a Down Arrow appears in the field in which you wish to enter information, click on the Down Arrow and then click on the desired value from those listed.

After you type or select the desired value for each field, press the Tab key.
Parking

The Parking tab allows you to enter the number of parking spaces available for the specified building.

Click on the Down Arrow and then click on the desired value from those listed.

After you select the desired value for the field, press the Tab key.
Miscellaneous

The Miscellaneous tab allows you to enter occupancy and other information about the specified building.

<table>
<thead>
<tr>
<th>Normal operating hours - year</th>
<th>3,744</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approximate number of people in building</td>
<td>N/A</td>
</tr>
<tr>
<td>Days per week normally occupied</td>
<td>6</td>
</tr>
<tr>
<td>Operating weeks per year</td>
<td>62</td>
</tr>
<tr>
<td>Number of women restrooms</td>
<td>29</td>
</tr>
<tr>
<td>Number of men restrooms</td>
<td>29</td>
</tr>
<tr>
<td>Number of unisex restrooms</td>
<td>19</td>
</tr>
<tr>
<td>Single-tenant bathrooms</td>
<td>Yes</td>
</tr>
</tbody>
</table>

If a Down Arrow appears in the field in which you wish to enter information, click on the Down Arrow and then click on the desired value from those listed.

After you type or select the desired value for each field, press the Tab key.
Handicap

The Handicap tab allows you to enter handicap accessibility information about the specified building. The choices classify each building feature as accessible (Yes), not accessible (No), partially accessible (Partial), or nonexistant (N/A).

If a Down Arrow appears in the field in which you wish to enter information, click on the Down Arrow and then click on the desired value from those listed.

After you type or select the desired value for each field, press the Tab key.
Building\Profile\Engineering

This function allows you to view or enter the engineering profile of a specified building.

Note: To enter profile information, your security level must be User or higher. If your security level is Guest, you will only be able to view profile data.

Most of the information in your engineering profile was established during your FCA System installation.

To view or enter engineering profile information:

1. Select Profile from the Building menu.
   The Profile menu appears.

2. Select Engineering from the Profile menu.
   The Select Building dialog box appears and lists the buildings included in the database.
   To list the buildings by building name, click on the Sort By: Building Name radio button.

3. Select the building for which you wish to enter or edit engineering profile information.
   The Engineering Profile window for the specified building appears.

   Engineering profile information is entered using the following tabs:
   Utilities
   HVAC
   Plumbing
   Electrical
Click on the tab for which you wish to enter or view information.

Click on the Save button to update this information in the database.
Utilities

The Utilities tab allows you to enter utilities cost information about the specified building.

After you type the desired value for each field, press the Tab key.
HVAC

The HVAC tab allows you to enter information about the heating, ventilation, and air conditioning facilities of the specified building.

<table>
<thead>
<tr>
<th>HVAC</th>
</tr>
</thead>
<tbody>
<tr>
<td>air conditioning</td>
</tr>
<tr>
<td>total square feet air conditioned</td>
</tr>
<tr>
<td>heating - type of fuel</td>
</tr>
<tr>
<td>heating - backup fuel</td>
</tr>
<tr>
<td>total square feet heated</td>
</tr>
<tr>
<td>energy management systems</td>
</tr>
<tr>
<td>hvac controls - type</td>
</tr>
<tr>
<td>supply fans - quantity</td>
</tr>
<tr>
<td>return fans - quantity</td>
</tr>
<tr>
<td>exhaust fans - quantity</td>
</tr>
<tr>
<td>single zone</td>
</tr>
<tr>
<td>multi-zone</td>
</tr>
<tr>
<td>constant volume</td>
</tr>
</tbody>
</table>

If a Down Arrow appears in the field in which you wish to enter information, click on the Down Arrow and then click on the desired value from those listed.

After you type or select the desired value for each field, press the Tab key.
Plumbing

The Plumbing tab allows you to enter information about the plumbing facilities of the specified building.

If a Down Arrow appears in the field in which you wish to enter information, click on the Down Arrow and then click on the desired value from those listed.

After you type or select the desired value for each field, press the Tab key.
Electrical

The Electrical tab allows you to enter information about the electrical facilities of the specified building - including lighting levels (measured in foot-candles).

![Engineering Profile - Building 001: CENTRAL CLINIC](image)

After you type the desired value for each field, press the Tab key.
Building/Drawings

This function allows you to link building-related projects to AutoCAD floor plans. You should use this feature only if you are familiar with AutoCAD.

Note: To enter drawings information, your security level must be User or higher. If your security level is Guest, you will only be able to view this data.

When you select Drawings from the Building menu, the Drawings window appears.

When you first access the Drawings window, the names of all drawings for all buildings are listed in the Drawings section. The drawing name is the same as the name of the file containing the drawing (minus the .DWG suffix).

In the name EC001F01, "EC" is the campus abbreviation, "001" is the building code, and "F01" is the floor number.

The Projects section displays the numbers of the projects related to the selected drawing (indicated by the solid arrow).

The following additional topics are available:
  List drawings by building
  List drawings by drawing
  Add a drawing to the drawing list
Add a project to the project list
The Import function
List Drawings by Building

To list drawings by building:

1. Click on the Select By: Building radio button. The Select Building dialog box appears. To list the buildings by building name, click on the Sort By: Building Name radio button.

2. Select the building whose drawings you wish to list. The Drawings section lists only the drawings for the selected building.
List Drawings by Drawing

To list drawings by drawing:

1. Click on the Select By: Drawing radio button.
   The Enter Drawing Name dialog box appears.

   ![Enter Drawing Name dialog box]

   Enter a Drawing Name or Wildcards (*.?, etc)
   [OK] [Cancel]

   ?????F01

2. Enter the name of the drawing(s) you wish to list.
   For example: Enter "?????F01" to list only the first floor drawings for all buildings.
   The Drawings section lists only the drawings specified.
Add a Drawing to the Drawings List

To add a drawing to the Drawings list:

1. Click on the Drawing Name field of the first blank line in the Drawings section.

```
<table>
<thead>
<tr>
<th>Drawing Name</th>
<th>Building</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EC001F01</td>
<td>001</td>
<td>FIRST FLOOR</td>
</tr>
<tr>
<td>EC001F02</td>
<td>001</td>
<td>SECOND FLOOR</td>
</tr>
<tr>
<td>EC001F03</td>
<td>001</td>
<td>THIRD FLOOR</td>
</tr>
<tr>
<td>EC001F04</td>
<td>001</td>
<td>FOURTH FLOOR</td>
</tr>
<tr>
<td>EC001F05</td>
<td>001</td>
<td>FIFTH FLOOR</td>
</tr>
<tr>
<td>EC001T01</td>
<td>001</td>
<td>TUNNEL FLOOR</td>
</tr>
<tr>
<td>EC002F01</td>
<td>002</td>
<td>FIRST FLOOR</td>
</tr>
<tr>
<td>EC002F02</td>
<td>002</td>
<td>SECOND FLOOR</td>
</tr>
<tr>
<td>EC002F03</td>
<td>002</td>
<td>THIRD FLOOR</td>
</tr>
<tr>
<td>EC002F04</td>
<td>002</td>
<td>FOURTH FLOOR</td>
</tr>
<tr>
<td>EC002F05</td>
<td>002</td>
<td>FIFTH FLOOR</td>
</tr>
<tr>
<td>EC002F06</td>
<td>002</td>
<td>SIXTH FLOOR</td>
</tr>
<tr>
<td>EC002T01</td>
<td>002</td>
<td>TUNNEL FLOOR</td>
</tr>
</tbody>
</table>
```

2. Enter the name of the drawing and press the Tab key.

3. Enter the number of the building for which the drawing was created and press the Tab key.

4. Enter (as the description) the name or number of the floor for which the drawing was created and press the Tab key.

```
<table>
<thead>
<tr>
<th>Drawing Name</th>
<th>Building</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EC002F06</td>
<td>002</td>
<td>SIXTH FLOOR</td>
</tr>
<tr>
<td>EC002T01</td>
<td>002</td>
<td>TUNNEL FLOOR</td>
</tr>
<tr>
<td>EC002F07</td>
<td>002</td>
<td>SEVENTH FLOOR</td>
</tr>
</tbody>
</table>
```
Add a Project to the Projects List

To add a project to the Projects list:

1. Select the name of the drawing with which the project is related.

2. Click on the first blank line of the Projects section.

3. Click on the Down Arrow to list the projects entered for the building for which the selected drawing was created.

4. Select the project to add to the projects list.
The Import Function

The Import function is used to import drawings data from an AutoCAD text file. It is used mostly by ISES to import information about groups of drawings instead of keying the data for each drawing.

To import drawings data:
1. Click on the Import button.
   The Select an AutoCAD ASCII Datafile dialog box appears.

![Select an AutoCAD ASCII DataFile...](image)

2. Enter or select the name of the text file containing the drawing information you wish to import.
   Use the directories Browse feature if you need to specify a different path for the filename.
Building/Photo Log

This function allows you to maintain an inventory of photographs taken during a building inspection.

The photos provide a visual record of the building's condition and help illustrate which maintenance-related projects are needed for the building.

Note: To enter photo information, your security level must be User or higher. If your security level is Guest, you will only be able to view this data.

When you select Photo Log from the Building menu, the Photo Log window appears.

When you first access the Photo Log window, all photos for all buildings are listed.

To list the photos for a particular building only:
1. Click on the Down Arrow next to the Buildings field. The buildings included in the database are shown.

2. Click on the building whose photos you wish to list.

3. Click in any field of the photo listing you wish to select. The currently selected photo listing is indicated by the solid arrow.
The Photo Description section displays a more complete version of the selected photo’s description than can be shown in the Description field of the listing.

The photo described in the selected listing is shown in the bottom right corner of the Photo Log window:
- if the Show Photo check box is checked
- and
- if the listing has been linked to the correct photo file in the Images directory.

(See Utility/Customize - Application Data tab.)

The following additional topics are available:
- Add a photo listing
- Link photo listing with photo file
Add a Photo Listing

To add a photo listing:

1. Click in the Photo ID field of the first blank line.

2. Enter the photo ID and press the Tab key.
   The first character of the Photo ID indicates which survey the photo applies to.
   For example: Enter “0” for an initial survey, “A” for the first update survey, “B” for the second update survey, and so on.
   The next three characters indicate the photo ID number.

3. Enter the sequence number of the photo and press the Tab key.
   For example: For the first photo in a building sequence, enter “01”.
   Otherwise, enter the next number in the building photo sequence.

4. Click on the Down Arrow in the Building field to list the buildings available and select the building for which the photo was taken.

5. Enter the photo location and press the Tab key.

6. Enter the photo description and press the Tab key.
Link Photo Listing with Photo File

To link a photo listing with a photo file:
1. Select the listing you wish to link to the photo file.

2. Click on the Synchronize button.
   The Adding Photos dialog box appears and identifies the first photo file found with no link to the Photo Log. The file is identified by its photo ID and sequence numbers.

   ![Adding Photos Dialog Box]

   Photo ID 000, Sequence 201 is not in the Photo Log. Add it?

   Yes  No  Add All  Cancel

3. If the photo file identified is the one with which you wish to link the specified listing, click on the Yes button.
   Otherwise, click on the No button until the photo file identified in the Adding Photos dialog box is correct. Then click on the Yes button.
Building/Groups

This function allows you to group buildings for reporting purposes. Each building can be included in more than one group.

Note: To create or delete groups, your security level must be User or higher. If your security level is Guest, you will only be able to view this data.

When you select Groups from the Building menu, the Building Groups window appears.

The following additional topics are available:
- Add building(s) to a group
- Delete building(s) from a group
- Add a new group code
- Delete a group code
Add Building(s) to a Group

To add one or more buildings to an existing group:
1. Click on the Down Arrow next to the Groups field to display the code and description of each group.
2. Select the group you wish to update.

3. To add one or more buildings to a group, select from the Available Buildings list and click on the single right-pointing arrow (>) button. The building is removed from the Available Buildings list and added to the Group Buildings list.

4. To add all the buildings from the Available Buildings list, click on the double right-pointing arrow (>>) button. All the buildings are removed from the Available Buildings list and added to the Group Buildings list.

5. Click on the Save button to update this information in the database.
Delete Building(s) From a Group

To delete one or more buildings from a group:

1. Click on the Down Arrow next to the Groups field to display the code and description of each group.

2. Select the group you wish to update.

3. To delete a particular building, select the building from the Group Buildings list and click on the single left-pointing arrow (<) button. The building is removed from the Group Buildings list and added to the Available Buildings list.

4. To delete all the buildings from the Group Buildings list, click on the double left-pointing arrow (<<) button. All the buildings are removed from the Group Buildings list and added to the Available Buildings list.

   Note: A group consisting of zero buildings should be deleted from the system.

5. Click on the Save button to update this information in the database.
Add a New Group Code

To create a new group code and description:

1. Click on the Create Group button. The Group Code dialog box appears.

   ![Group Code Dialog Box]

   **Enter a 3 Character Group Code**

   **ABC**

2. Enter the three-character code for the new group. The Group Description dialog box appears.

3. Enter the description for the new group.

   ![Group Description Dialog Box]

   **Enter a group description**

   **ABC Group**

4. Click on the Down Arrow next to the Groups field to verify that the new group has been added to the group list.
Delete a Group Code

To delete a group code and description:
1. Click on the Down Arrow next to the Groups field to display the code and description of each group.

2. Select the group you wish to delete.

3. Click on the Delete Group button.

4. When the Verify Delete dialog box appears, click on the Yes button.

5. Click on the Down Arrow next to the Groups field to verify that the selected group has been deleted from the group list.
Building/Completion

This function allows ISES personnel to track the progress of building data entry. It is intended for use by ISES personnel only.

Note: To enter completion information, your security level must be User or higher. If your security level is Guest, you will only be able to view this data.

When you select Completion from the Building menu, the Data Completion window appears.

The current user's name displays in the Users field. To change users, click on the Down Arrow next to the Users field and select the new user's name.

The numbers of the buildings assigned to the current user are listed in the first column under Building.

To assign another building to the current user:
1. Click on the Add button. The Select Building dialog box appears. To list the buildings by building name, click on the Sort By: Building Name radio button.
2. Select the building you wish to assign. The number of the selected building is added to the user's list of buildings.

The check boxes in the next seven columns allow you to indicate:

- Trans The transcript of the building survey has been received by the ISES personnel assigned to the building.
- PES All the projects related to the building have been entered.
- ACAD All the drawings for the building have been turned in.
- Photo The photo log has been completed for the building.
Profile A  The architectural profile has been entered for the building.
Profile E  The engineering profile has been entered for the building.
Summary  The draft summary document has been completed.

The Date Mailed field is taken from the Building Management window and shows when the final report regarding the building was mailed to the client.

To mark an item of data entry complete:
1. Click on the data entry item you wish to mark complete.
   A border appears around the selected check box.

2. Click on the selected check box.
   A check mark appears in the check box.

To remove a check mark on a data entry item:
1. Click on the data entry item whose check mark you wish to remove.
   A border appears around the selected check box.

2. Click on the selected check box.
   The check mark disappears.

   Note:  You can remove check marks from your entries only.

To delete a building from the user's list:
1. Click on the number of the building you wish to delete from the list.
   A border appears around the building number to indicate that it has been selected.

2. Click on the Delete button.

3. When the Verify Delete dialog box appears, click on the Yes button.
   The selected building disappears from the list.
Building/Resequence

This function allows you to resequence (prioritize) building-related projects. The purpose of prioritizing is to determine the order in which projects should be completed.

Note: To resequence building projects, your security level must be Admin or higher. If your security level does not allow you to resequence projects, the Resequence option will not be active.

Resequecing should not be performed until all the projects for a building have been entered.

Project priority is determined internally by the FCA System and is based on the data entered for each building project. You can enter a priority value using the project entry function to override the value assigned.

To resequence a building project:
1. Select Resequence from the Building menu. The Select Building dialog box appears. To list the buildings by building name, click on the Sort By: Building Name radio button.

![Select Building Dialog Box]

2. Select the building whose projects you wish to resequence. Resequecing is implemented automatically. As resequencing occurs, a progress message displays in the bottom left corner of the FCA System window. For example: Resequencing Project 001HV02

3. When the Project Priorities Resequenced information box appears, click on the OK button to continue.
Building/Search

This function allows you to query the FCA database to locate one or more building records by the criteria you specify.

Note: You can perform a query regardless of your security level.

When you select Search from the Building menu, the Query Building window appears.

Note: To delete all the lines of the Current Search Criteria, click on the Clear All button.
To delete a particular line of search criteria, select the line and then click on the Delete button.

To perform a query:
1. In the first Available Criteria field (from the list of building data entry fields), select the type of information you wish to use as the subject of the current query criteria line.
   For example: Square Feet

2. In the second Available Criteria field, select the condition for the current query criteria line.
   For example: Greater Than
   Note: If you select as the query subject a field that has look-up values (such as Campus), you must select Equal To or Not Equal To as the query condition.

3. In the third Available Criteria field, enter or select the value to compare to the subject using the specified condition for the current query criteria line.
   For example: 1000
4. Click on the Add button to add the new Available Criteria line to the Current Search Criteria.

![Query Building dialog box](image1)

5. Repeat steps 1, 2, 3, and 4 until you have built the query you want.

6. Click on the Show Columns button to list the building data fields.

![Show Fields dialog box](image2)

7. Click on each field you wish to include in the Query Results. If you selected a field by mistake, click on the field again to deselect it. The building Name field is included automatically as the first field in the Query Results.

8. Click on the OK button.

9. Click on the Query button. All building records matching the specified criteria are listed in the Query Results area. The columns can be resized by dragging the header margins.
10. Click on the Print button to display a report preview window. (See Reports section.)

To sort the results of the query:
1. Click on the title of the column by which you wish to sort the results.

2. Click on the Sort Results button.

To view or update the information for a building located by the query:
1. Select the building from the Query Results list.

2. Click on the Details button.
   The Building Management dialog box appears.
Conditionals

Equal To -- Record selected if value in specified subject field is equal to value entered in comparison field.

Not Equal To -- Record selected if value in specified subject field is not equal to value entered in comparison field.

Less Than -- Record selected if value in specified subject field is less than value entered in comparison field.

Greater Than -- Record selected if value in specified subject field is greater than value entered in comparison field.

Between -- Record selected if value in specified subject field equals or falls between either of the values entered in comparison field.

Starts With -- Record selected if value in specified subject field starts with value entered in comparison field.
You can expand the search by using the wild card ("**") in the value of the comparison field.

Like -- Record selected if any part of value in specified subject field matches value entered in comparison field.
You can expand the search by using the wild card ("**") in the value of the comparison field.
Project/Entry

This function allows you to create and edit building-related projects. You can also use this function to copy a project to the project library.

Note: To enter project information, your security level must be User or higher. If your security level is Guest, you will only be able to view project data.

To copy a project, your security level must be SuperUser or higher. If your level of security does not allow you to copy projects, the Copy button will not be active.

Projects are created to specify how building deficiencies should be corrected and what the corrections will probably cost. Each project must pertain to a specific building component.

The first projects are determined by the ISES survey and entered prior to the FCA System installation. Subsequent projects may result from client inspections, tenant requests, and/or other ISES surveys.

When entering a project, always use the codes established by ISES for your FCA System.

The following additional topics are available:

- Notes
- Custom Fields
- Copying Projects to Groups
View/Edit a Project

To view and/or edit a project:

1. Select Entry from the Project menu.
   The Select Building dialog box appears and displays the buildings included in the FCA database. To list the buildings by Building Name, click on the Sort By: Building Name radio button.

2. Select the building related to the project you wish to edit.
   The Projects dialog box appears and displays the projects existing for the specified building.

If the Show History Projects check box is checked, the list includes completed projects.
Note: To delete a particular project, select the project to delete and click on the Delete button. The information is permanently removed from the database. If it is needed later, it must be reentered.

If your level of security does not allow you to delete projects, the Delete button will not be active.

3. Click on the project you wish to edit and then click on the View button.

The Project Entry window appears for the project number specified. The number and name of the building to which the project is related is shown in the upper-right corner of the window.

Project information is edited using the following tabs:
- Information
- Reference
- Description
- Material
- Labor
- Totals

Click on the tab for which you wish to enter or view information.

To save the edited project to the FCA database, click on the Save button.

If the Drawings icon is active, a link exists between the current project and one or more AutoCAD drawings.

To view the AutoCAD drawing(s) linked to the current project:
1. Click on the Drawings icon.
   The drawings linked to the current project are listed.

2. Select the drawing you wish to view.
   The AutoCAD program is launched and the selected drawing is displayed.
Create a Project

You can create a new project from scratch or base it on a library project.

To create a project from scratch:

1. Select Entry from the Project menu. The Select Building dialog box appears and displays the buildings included in the FCA database. To list the buildings by Building Name, click on the Sort By: Building Name radio button.

2. Select the building for which you wish to create a project. The Projects dialog box appears and displays the projects existing for the specified building.
Note: To delete a particular project, select the project to delete and click on the Delete button. The information is removed from the database. If it is needed later, it must be reentered.

If your level of security does not allow you to delete projects, the Delete button will not be active.

3. Click on the New button.
The Project Entry - New Project window appears. New project information is entered using the following tabs:
   - Information
   - Reference
   - Description
   - Material
   - Labor
   - Totals

Click on the tab for which you wish to enter or view information.
Create New Project Based on Library Project

To save time, you can base a new project on a library project.

To base a new project on a library project:
1. Click on the Library button (instead of the New button). When the Project Library dialog box appears, click on the Retrieve Project From Library radio button.

2. Click on the project you wish to use and then click on the OK button. The Project Entry - New Project window will appear and display the data from the selected library project.

Note: All data existing in a library project must be customized to the situation it is being applied to.
Information

The Information tab allows you to enter general and classifying information about the current project.

The following are required fields:
- Title
- Category Code
- Project Class
- Priority Class
- SubClass
- Engineering Sequence
- Project Ratings

You can enter the value for the Category Code field directly or you can derive the code by selecting values for the three fields which comprise the category code -- System Code, Component Code, and Element Code.

Note: If you enter the category code directly, the values for the other three fields will be provided automatically.

Select the values for the following fields from the lists provided:
- Project Class
- Priority Class
- SubClass
- Project Ratings: Rating

The Assessment Code and Priority Physical fields are for future use and will not accept data.
The value for the Priority Sequence field is updated automatically when the Resequence function of the Building menu is run. Enter a value for this field only when you wish to override the assigned value.

Enter a value for the Savings (estimate) field only if "Energy Conservation" has been selected as the value for the SubClass field.

To specify project ratings for the current project:
1. Click in the Rating field of the first blank line of the Project Ratings section.

2. Click on the Down Arrow to list the project ratings available.

3. Click on the rating you wish to select and then press the Tab key. The value for the Description field is provided automatically when you select the rating.

4. Repeat Steps 1 through 3 for each rating you wish to apply to the current project.
Reference

The Reference tab allows you to enter project location and building standard information.

The following are required fields:
- Icon
- Extent
- Occurrences

The Icon field is for ISES use only. It is set automatically to the engineering sequence number.

Select the values for the following fields from the lists provided:
- Floors
- Extent
- Photos
- Building Standards: Code

To select one or more photos to relate to the current project:
1. Click on the Select Photos button.
   The list of photos taken for the specified building displays.
2. Click on the database number of each photo you wish to relate to the project. If you select a photo by mistake, click on the photo database number again to deselect it.

3. Click on the OK button.
   The database numbers of the photos selected are listed in the Photos section. Double-click on the database number of each photo you wish to view.

To specify which (if any) building standards apply to the current project:
1. Click in the Code field of the first blank line of the Building Standards section.

2. Click on the Down Arrow to list the building standard codes available.

3. Click on the code you wish to select and then press the Tab key.

4. Enter the Application field value for specific code reference number and press the Tab key.

5. Repeat Steps 1 through 4 for each building standard you wish to apply to the current project.
Description

The Description tab allows you to enter project details concerning the deficiency being addressed, recommended corrections, and any project assumptions.

Project Description is a required field.

The Update History section displays the name of each user who made changes to the current project and the date the changes were made. The data in this section is view only.
Material

The Material tab allows you to enter material cost estimates for the current project.

Information is required for at least one material item. For each item you must enter data for the Material, Unit, Quantity, and Price fields.

Select the unit value from the list of values provided. Use the "Lot" value if the exact unit cannot be specified.

The Amount field contains the Price value multiplied by the material Quantity.

The materials local price index is not applied to the Material Subtotal amount.

To determine the overall Cost Per Unit for a particular material:
1. Select the row containing the material.
2. Click on the Set Cost Per Unit button.
   The Cost Per Unit is the value obtained by dividing the Project Total (shown on the Totals tab) by the Quantity shown for the selected material.
Labor

The Labor tab allows you to enter labor cost estimates for the current project.

Information is required for at least one labor item. For each item you must enter data for the Code and Hour fields.

Select the code value from the list of values provided.

The values for the Description and Rate fields are provided automatically when you select the labor code.

The Amount field contains the Rate value multiplied by the number of hours.

The labor local price index is not applied to the Labor Subtotal amount.

Labor rates selected in a new project will remain within that project even when the system labor rates are changed. This allows project totals to inflate in following years without altering the original project. To attach new labor rates to an existing project, click on the Update Labor Rates button.

To include professional fees in the total project cost, click on the Professional Fees check box.
Totals

The Totals tab allows you to display the total estimated costs for the current project.

<table>
<thead>
<tr>
<th>Project Totals</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Labor</td>
<td>$2,294.60</td>
</tr>
<tr>
<td>Total Material</td>
<td>$5,174.40</td>
</tr>
<tr>
<td>GCM</td>
<td>$1,491.00</td>
</tr>
<tr>
<td>Professional Fees</td>
<td>$1,974.10</td>
</tr>
<tr>
<td>Cost Escalation</td>
<td>$120.30</td>
</tr>
<tr>
<td>Sister Component Damage</td>
<td>$0.00</td>
</tr>
<tr>
<td>Project Total</td>
<td>$10,145.19</td>
</tr>
<tr>
<td>Variance</td>
<td>$10,145.19</td>
</tr>
<tr>
<td>Cost Per Unit</td>
<td>$1,377.00</td>
</tr>
</tbody>
</table>

Date Basis:
- (Survey Date) 08/23/95
- (Current Date)

The Total Labor and Total Material values reflect the application of the localization factors.

GCM (General Contractor Markup) is a user-specified percentage of the labor and material totals.

The Professional Fees amount (if shown) is a user-specified percentage of the labor total.

The Cost Escalation amount is determined by multiplying the Inflation Adjustment Factors by the sum of the first four amounts.

Sister Component Damage is a user-defined percentage of the sum of the first five amounts.

The Project Total is the sum of the previous six amounts.

The Variance is determined by subtracting the Backlog Reduction amount (entered using the Project History window) from the Project Total.

Click on the Date Basis: Current Date radio button for all projects not related to the original ISES inspection.
Original project cost information is based on information obtained at or near the survey date. Project estimates based on a later date should use the Current Date basis. Inflation in subsequent years will begin at this date.
Notes

To add notes to the project:
1. Click on the Notes button. The Notes for Project Entry window appears.

You can use this window to enter miscellaneous information about the project. This information does not appear on any reports or impact the project totals.
Custom Fields

The Custom button is active only if custom fields have been specified in the look-up tables of the Customize function.

To enter custom field data:
1. Click on the Custom button.
   The Project Custom Fields window appears.

2. Enter data for the custom fields.
Copying Projects to Groups

To create a copy of a new project for the other buildings of a group to which the current building belongs:

1. Click on the Groups button. The Select Group dialog box appears and lists the groups which include the building specified for the current project.

![Select Group dialog box](image)

2. Select the group which includes the buildings for which to wish to copy the current project.

   Note: If you intend to copy the project for the buildings in one or more groups, you must do so before you save the project. Projects must then be edited individually.
Copy Project To Library

To copy a project to the project library:

1. Select Entry from the Project menu.
   The Select Building dialog box appears and displays the buildings included in the FCA database. To list the buildings by Building Name, click on the Sort By: Building Name radio button.

2. Select the building related to the project you wish to add to the library.
   The Projects dialog box appears and displays the projects existing for the specified building.

If the Show History Projects check box is checked, the list includes completed projects.
3. Click on the project you wish to add to the library and then click on the Library button.

   The Project Library dialog box appears.

   ![Project Library dialog box]

   Click on the Add Selected Project To Library radio button and then click on the OK button.

   The selected project is added to the Projects In Library list at the bottom of the dialog box.
Project/History

This function allows you to view the update history of a specified project and to mark the project complete when appropriate. You can also use this function to enter backlog reduction amounts for the specified project.

Note: To enter project history data, your security level must be User or higher. If your security level is Guest, you will only be able to view this data.

To access the history of a specified project:

1. Select History from the Project menu.
   The Select Building dialog box appears and displays the buildings included in the FCA database. To list the buildings by Building Name, click on the Sort By: Building Name radio button.
2. Select the building related to the project whose history you wish to access. The Projects dialog box appears and displays the projects existing for the specified building. If the Show History Projects check box is checked, the list includes completed projects.

3. Click on the project whose history you wish to access and then click on the OK button.

The Project History window appears for the project number specified. The number and name of the building to which the project is related is shown on the right side of the window.

Project history is accessed using the following tabs:
- Description
- Backlog Reduction
- Project Totals

Click on the tab for which you wish to enter or view information.

To save the updated project history information to the FCA database, click on the Save button.
Description

The Description tab displays the description data added during project entry.

![Project History - Project Number 002FS03]

The Update History section displays the name of each user who made changes to the current project and the date the changes were made.

You can not change the data in either section of the Description tab.
Backlog Reduction

The Backlog Reduction tab allows you to enter the actual amount expended to complete the various stages of the current project.

For each backlog reduction, enter the completion date of the specified project stage, the actual amount expended during the project stage, and the description of the work completed.

The amount entered in the Cost field is used to calculate the project total cost variance.
Project Totals

The Project Totals tab allows you to display the total estimated costs for the current project. This tab also allows you to mark the current project complete.

The Total Labor and Total Material values reflect the application of the localization factors.

GCM (General Contractor Markup) is a user-specified percentage of the labor and material totals.

The Professional Fees amount (if shown) is a user-specified percentage of the labor total.

The Cost Escalation amount is determined by multiplying the Inflation Adjustment Factors by the sum of the first four amounts.

Sister Component Damage is a user-defined percentage of the sum of the first five amounts.

The Project Total is the sum of the previous six amounts.

The Variance is determined by subtracting the Backlog Reduction from the Project Total.

To mark the current project complete, click in the Project Completed check box. The project is archived in the FCA System database but the project information is not deleted. Data from completed projects is not included in FCA System reports.
If you click in the Project Completed check box when the check box contains an "x", the project is reactivated and its information will again be included in FCA System reports.
Project/Copy

This function allows you to copy a project created for one building to use for a different building.

Note: To copy a project, your security level must be Admin or higher.

If your level of security does not allow you to copy projects, the Copy button will not be active.

To copy a specified project:

1. Select Copy from the Project menu.
   The Select Building dialog box appears and displays the buildings included in the FCA database. To list the buildings by Building Name, click on the Sort By: Building Name radio button.

![Select Building dialog box with building options: CENTRAL CLINIC, SOUTH CLINIC AND ADDITION, PHYSICIAN'S PARKING DECK]

Sort By:
- Building Code
- Building Name
2. Select the building related to the project you wish to copy. 
The Select Project For Copying dialog box appears and displays the projects existing for the 
specified building.

3. Click on the project you wish to copy and then click on the Copy button. 
   
   Note: If you click on the View button, you will be able to view but not change the 
   details of the selected project.

   The Copy Project To Selected Building dialog box appears and lists the remaining buildings 
in the FCA database.

4. Click on the building you want to copy the project for and then click on the Copy Project 
   button.
An information box warns you of any special circumstances regarding the copy.

5. Click on next building you want to copy the project for or click on the Cancel button to end the Copy operation.
Project/Search

This function allows you to query the FCA database to locate one or more building-related projects by the criteria you specify.

Note: You can perform a query regardless of your security level.

When you select Search from the Project menu, the Query Project window appears and lists the Current Search Criteria (if any).

Note: To delete all the lines of the Current Search Criteria, click on the Clear All button.
To delete a particular line of search criteria, select the line and then click on the Delete button.

To perform a query:

1. In the first Available Criteria field (from the list of project data entry fields), select the type of information you wish to use as the subject of the current query criteria line.
   For example: Total Cost

2. In the second Available Criteria field, select the condition for the current query criteria line.
   For example: Greater Than

   Note: If you select as the query subject a field that has look-up values (such as Building Code), you must select Equal To or Not Equal To as the query condition.

3. In the third Available Criteria field, enter or select the value to compare to the subject using the specified condition for the current query criteria line.
For example: 10000

4. Click on the Add button to add the new Available Criteria line to the Current Search Criteria.

5. Repeat steps 1, 2, 3, and 4 until you have built the query you want.

6. Click on the Show Columns button to list the project data fields.

7. Click on each field you wish to include in the Query Results. If you selected a field by mistake, click on the field again to deselect it. The Project Number field is included automatically as the first field in the Query Results.

8. Click on the OK button.

9. Click on the Query button. All projects matching the specified criteria are listed in the Query Results area. The columns can be resized by dragging the header margins.
10. Click on the Print button to display a report preview window. (See Reports section.)

To sort the results of the query:
1. Click on the title of the column by which you wish to sort the results.

2. Click on the Sort Results button.

To view or update the information for a project located by the query:
1. Select the project from the Query Results list.

1. Click on the Details button.
The Project Entry dialog box appears.
Conditions

Equal To -- Record selected if value in specified subject field is equal to value entered in comparison field.

Not Equal To -- Record selected if value in specified subject field is not equal to value entered in comparison field.

Less Than -- Record selected if value in specified subject field is less than value entered in comparison field.

Greater Than -- Record selected if value in specified subject field is greater than value entered in comparison field.

Between -- Record selected if value in specified subject field equals or falls between either of the values entered in comparison field.

Starts With -- Record selected if value in specified subject field starts with value entered in comparison field.
You can expand the search by using the wild card ("*") in the value of the comparison field.

Like -- Record selected if any part of value in specified subject field matches value entered in comparison field.
You can expand the search by using the wild card ("*") in the value of the comparison field.
Project/Library

This function allows you to create and edit library projects. Library projects are created to serve as templates in order to standardize cost estimating procedures among users.

Note: To create a library project, your security level must be User or higher. If your security level is Guest, you will only be able to view library project data.

Library projects will usually be created by ISES personnel.
Create a Library Project

To create a library project:

1. Select Library from the Project menu.
   The Select Library Project dialog box appears and displays the existing library projects.

   ![Select Library Project Dialog Box]

   Note: To delete a particular library project, select the project to delete and click on the Delete button. The information is permanently removed from the database. If it is needed later, it must be reentered.

   If your level of security does not allow you to delete library projects, the Delete button will not be active.

2. Click on the New button.
   The Library Entry - New Library Project window appears. New library project information is entered using the following tabs:
   - Information
   - Reference
   - Description
   - Material
   - Labor

   Click on the tab for which you wish to enter or view information.

   Note: No required fields are used during library project entry
To add notes to the project, click on the Notes button. The Notes for Library Entry window appears. You can use this window to enter miscellaneous information about the project.

<table>
<thead>
<tr>
<th>Task/Item</th>
<th>Reference</th>
<th>Description</th>
<th>Material</th>
<th>Labor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes for Library Entry - New Library Project</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To save the project to the library, click on the Save button.
Information

The Information tab allows you to enter general and classifying information about the current library project.

Select the values for the following fields from the lists provided:
- Project Class
- Priority Class
- SubClass
- Priority Physical
- Project Ratings: Rating

You can enter the value for the Category Code field directly or you can derive the code by selecting values for the three fields which comprise the category code -- System Code, Component Code, and Element Code.

Note: If you enter the category code directly, the values for the other three fields will be provided automatically.

The Assessment Code and Priority Physical fields are for future use and will not accept data.

Enter a value for the Savings (estimate) field only if "Energy Conservation" has been selected as the value for the SubClass field.
To specify project ratings for the library project:

1. Click in the Rating field of the first blank line of the Project Ratings section.

2. Click on the Down Arrow to list the project ratings available.

3. Click on the rating you wish to select and then press the Tab key.
   The value for the Description field is provided automatically when you select the rating.

4. Repeat Steps 1 through 3 for each rating you wish to apply to the library project.
Reference

The Reference tab only allows you to enter building standard information for the library project.

Select the values for the Building Standards: Code field from the list provided:

To specify which (if any) building standards apply to the current project:
1. Click in the Code field of the first blank line of the Building Standards section.
2. Click on the Down Arrow to list the building standard codes available.
3. Click on the code you wish to select and then press the Tab key.
4. Enter the Application field code reference number value and press the Tab key.
5. Repeat Steps 1 through 4 for each building standard you wish to apply to the current project.
Description

The Description tab allows you to enter library project details as a basis for building-specific projects. Such details include the deficiency addressed and a recommended course of action.

![Library Entry - Library Project Number LIBES01](image)

The existing roof system is comprised of six different sections reflecting the various phases of construction below. The current roofing is upside-down built-up roof, which has a questionable design and a deteriorated installation. The entire roofing system should be replaced with a modified bitumen torched down roof including new insulation for proper sloped

Project Description is a required field.

The Update History section displays the name of each user who made changes to the current library project and the date the changes were made. The data in this section is view only.
Material

The Material tab allows you to enter standardized material cost estimates for the current library project.

For each material item you specify, you must enter data for the Material, Unit, and Quantity fields.

Select the unit value from the list of values provided. Use the “Lot” value if the exact unit cannot be specified.

The Amount field contains the Price value multiplied by the material Quantity.

The material localization factor is not applied to the Material Subtotal amount.
Labor

The Labor tab allows you to enter standardized labor cost estimates for the current library project.

For each labor item you specify, you must enter data for the Code and Hour fields.

Select the code value from the list of values provided.

The values for the Description and Rate fields are provided automatically when you select the labor code.

The Amount field contains the Rate value multiplied by the number of hours.

The labor localization factor is not applied to the Labor Subtotal amount.

If the labor rates have been changed in the look-up tables of the Customize function, click on the Update Labor Rates button.

To include professional fees in the total library project cost, click on the Professional Fees check box.
View/Edit Library Project

To view and/or edit a library project:

1. Select Library from the Project menu.
   The Select Library Project dialog box appears and displays the existing library projects.

   ![Select Library Project dialog box]

   Note: To delete a particular library project, select the project to delete and click on the Delete button. The information is removed from the database. If it is needed later, it must be reentered.

   If your level of security does not allow you to delete library projects, the Delete button will not be active.

2. Click on the library project you wish to view or edit and then click on the View button.

   The Library Entry window appears for the library project specified.

   Project information is edited using the following tabs:
   - Information
   - Reference
   - Description
   - Material
   - Labor

   Click on the tab for which you wish to enter or view information.

   Note: No required fields are used during library project entry.
To add notes to the library project, click on the Notes button. The Notes for Library Entry window appears. You can use this window to enter miscellaneous information about the library project.

To save the edited library project, click on the Save button.
EEM/Entry

This function allows you to create scenarios to help predict future backlog levels and funding predictions based on different funding and inflation rates.

Note: To enter EEM information, your security level must be User or higher. If your security level is Guest, you will only be able to view EEM data.

When you select Entry from the EEM menu, the EEM Library dialog box appears and displays the list of existing Engineering Economy Module scenarios.

![EEM Library](image)

Note: To delete an EEM scenario, select the scenario you wish to delete and click on the Delete button. The selected scenario disappears from the EEM Library list.

If your level of security does not allow you to delete EEM scenarios, the Delete button will not be active.

Select the EEM scenario for which you wish to view or edit information and click on the Load button.

or

Click on the New button to enter information for a new EEM scenario.

The Engineering Economy Module window appears.
For each scenario, you can create or change Funding Projection.

To save a new or updated scenario:

1. Click on the Save button.
   The Save As dialog box appears.

2. In the New Name for Model field, enter the name you wish to save your model as:
   ![Save As dialog box]

3. When the information box appears to inform you that the model has been saved, click on the OK button to continue.
Note: An error message displays if you try to save a new scenario using an existing scenario name. Click on the OK button to continue.
Backlog Projection

The backlog projection model calculates future maintenance levels based on given funding levels.

You can change a Backlog Projection model for an existing scenario or create a Backlog Projection model for a new scenario.
Change a Backlog Projection

To change a Backlog Projection model for an existing scenario:

1. Change the value (if desired) in any of the following fields:
   - Budget Years
   - Funding Years
   - Plant Loss Rate
   - Backlog Loss Rate
   - Inflation Rate
   - Growth Rate
   - Initial Backlog
   - Replacement Value

2. Click on the Investment Rates % button to change one or more reinvestment rates. The Reinvestment Rates dialog box appears and lists the reinvestment rates currently in use.
3. Click on the Down Arrow button of each rate you wish to change and select the new rate.

4. Click on the OK button. The new rates are shown on the Backlog Projection tab and the projections are updated accordingly.
Create a Backlog Projection

To create a Backlog Projection model for a new scenario:

1. Click on the Select button to select the building(s) to include in the scenario. The Select Building dialog box appears.

2. Click on the building you wish to include. To include one or more other buildings, press and hold the Shift key and click on each of the other buildings you wish to include. To include all the buildings listed, click on the word "All" in the buildings list. To include buildings by group, click on the Down Arrow next to the Building Groups field and then click on the name of the building group you wish to use.

3. Click on the OK button. The buildings selected display in the Buildings area.

4. Click on the Example button to load sample default data for the scenario. The default values are based on the N.A.C.U.B.O. standards model. You can change the information in any of the fields not located on the Backlog Projection tab.

   Note: You can only load sample default data for a new scenario.
5. Click on the Investment Rates % button to change one or more reinvestment rates. The Reinvestment Rates dialog box appears and lists the reinvestment rates currently in use.

6. Click on the Down Arrow button of each rate you wish to change and select the new rate.

7. Click on the OK button. The new rates are shown and the backlog projections are updated accordingly.
Funding Projection

The funding projection model calculates the level of annual funding required to produce a desired backlog level.

You can change a Funding Projection model for an existing scenario or create a Funding Projection model for a new scenario.
Change a Funding Projection

To change a Funding Projection model for an existing scenario:

1. Change the value (if desired) in any of the following fields:
   - Budget Years
   - Funding Years
   - Plant Loss Rate
   - Backlog Loss Rate
   - Inflation Rate
   - Growth Rate
   - Initial Backlog
   - Replacement Value

2. Click on the Funding Projection tab.

3. Click on the Target Backlog $ button to change one or more of the Target Backlog values. The Target Backlog Amounts dialog box appears and lists the target backlog amounts currently in use.
4. Change any of the target backlog amounts as desired.

5. Click on the OK button.
The new target backlog amounts are shown on the Funding Projection tab and the projections are updated accordingly.
Create a Funding Projection

To create a Funding Projection model for a new scenario:

1. Click on the Select button to select the building(s) to include in the scenario. The Select Building dialog box appears.

   ![Select Building Dialog Box](image)

   **Selected Buildings:**
   - All
   - 001 CENTRAL CLINIC
   - 002 SOUTH CLINIC AND ADDITION
   - 999 PHYSICIAN’S PARKING DECK

   **Building Group:**

2. Click on the building you wish to include.
   To include one or more other buildings, press and hold the Shift key and click on each of the other buildings you wish to include.
   To include all the buildings listed, click on the word “All” in the buildings list.
   To include buildings by group, click on the Down Arrow next to the Building Groups field and then click on the name of the building group you wish to use.

3. Click on the OK button.
   The buildings selected display in the Buildings area.

4. Click on the Example button to load sample default data for the scenario.
   The default values are based on the N.A.C.U.B.O. standards model. You can change the information in any of the fields not located on the Funding Projection tab.

   **Note:** You can only load sample default data for a new scenario.
5. Click on the Funding Projection tab.

6. Click on the Target Backlog $ button to change one or more of the Target Backlog values. The Target Backlog Amounts dialog box appears and lists the target backlog amounts currently in use.

7. Change any of the target backlog amounts as desired. Click on the OK button. The new target backlog amounts are shown on the Funding Projection tab and the projections are updated accordingly.
**Budget Years**
The number of budget years is the number of years used to calculate the results of the backlog projections.

**Funding Years**
The number of funding years is the number of years used to calculate the results of the funding projections. The funding years value should be greater than or equal to the budget years value.

**Plant Loss Rate**
The plant loss rate is the annual percentage rate of overall plant deterioration. This value includes equipment maintenance and repair, component renewal, etc.
   For example: Enter "4.50" to represent 4.50%.

**Backlog Loss Rate**
The backlog loss rate is the annual percentage rate of backlog deterioration. A component with an existing deficiency usually deteriorates at an annual rate greater than a component in good condition.
   For example: Enter "4.50" to represent 4.50%.

**Inflation Rate**
Inflation rate is the projected annual inflation rate. It is used to indicate how much more a deficiency will cost to correct next year due to higher material and labor costs.
   For example: Enter "4.50" to represent 4.50%.

**Growth Rate**
Growth rate is the projected percentage rate of planned increase in gross square footage per year from the time of initial construction, acquisition, or disposal of the specified building or groups of buildings. As the square footage increases, so does the potential for project expenditures.
   For example: Enter "4.50" to represent 4.50%.

**Initial Backlog**
Initial backlog is the total estimated expenditures for all the projects related to the specified building or group of buildings. This field value is provided automatically.
   For example: $10,500,000

**Replacement Value**
Replacement value is the total facility replacement cost for the specified building or group of buildings. The value is provided automatically.
   For example: $12,300,000
EEM/Graph

This function allows you to create graphs to illustrate Backlog Projections and Funding Projections for new and existing Engineering Economy Module scenarios. It is only available after you access the Engineering Economy Model window.

**Note**  Do not use the Graph function for a new scenario until the Backlog and Funding Projections have been calculated.

To create a Backlog Projection graph:
1. Click on the Backlog Projection tab.
2. Select Graph from the EEM menu.
   The FCA Plot window displays the graph created using the current backlog projection data.

To create a Funding Projection graph:
1. Click on the Funding Projection tab.
2. Select Graph from the EEM menu.
   The FCA Plot window displays the graph created using the current funding projection data.
FCA Plot Window

The FCA Plot window provides menu options you can use to modify the appearance of the currently displayed graph. Other menu options allow you to save and print the graph and switch between the plot and data entry windows.

The following menus are available from the FCA Plot window:
File
Grid
Lines
Text

Note: The operation of the Window menu is standard so no explanation is provided here.
File

Select Close to close the FCA Plot window and return to the Engineering Economy Model window.

When you select Print Graph To from the File menu, the Print Graph To menu appears.

Select File to save the graph in the filename at the path you specify. The graph will be saved using the Windows metafile format.

Select Printer to print the graph on the FCA System printer.

Select Clipboard to copy the graph to the Windows clipboard.

Grid

Select Horizontal to display horizontal graph lines only.

Select Vertical to display vertical graph lines only.

Select Both to display both horizontal and vertical graph lines.

Select None to display no graph lines.

Lines

Select Thin to display thin graph plot lines.

Select Thick to display thick graph plot lines.
Text

Select Graph Title to change the title of the graph.

Select X Axis to change the X axis identifier.

Select Y Axis to change the Y axis identifier.
Reports/Selected Reports

This function allows you to access the reports included in the specified report lists.

Note: You can create a report regardless of your security level.

The procedures for creating, viewing, and printing reports are generally the same for the following report types:
- Elevator Reports
- Equipment Reports
- Executive Summary Reports
- Miscellaneous Reports
- Print Graphs
- Special Reports

Note: Other report types can be established using the Customize function.

When you select one of the above options from the Report menu, the Report Selection window appears and lists the reports available for the type selected.

If you select only one report, you can view the report before printing and/or exporting it.
If you select more than one report, you can only print the selected reports.
View a Selected Report

To view a selected report:
1. Select the type of report you wish to view.
   The Report Selection window appears and lists the reports available for the type selected.

   ![Report Selection Window](image)

   - **Section**
   - **Report Name**
     - 1.3 Elevator Exec-Sum Building Summary
     - 1.4 Elevator Exec-Sum Car Summary
     - 1.5 Elevator Exec-Sum Car Detail
     - 3.1 Elevator Project Detail
     - 3.2 Elevator Project-Contractor Detail

2. Click on the name of the report you wish to view.

3. To include the current date on the report, click on the Print Date check box.

4. Click on the View button.
   The Select Building/Group dialog box appears and lists the buildings in Building Code order.
   To list the buildings by name, click on the Sort By: Building Name radio button.

   To list the building groups, click on the Groups radio button. To list the Groups by name,
   click on the Sort By: Group Name radio button.
Select Building/Group

<table>
<thead>
<tr>
<th>Buildings</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>001 CENTRAL CLINIC</td>
<td></td>
</tr>
<tr>
<td>002 SOUTH CLINIC AND ADDITION</td>
<td></td>
</tr>
<tr>
<td>999 PHYSICIAN’S PARKING DECK</td>
<td></td>
</tr>
</tbody>
</table>

Note: Depending on the specified report, the Select Building/Group dialog box may allow you to list both buildings and building groups, or buildings only, or building groups only.

Also, some reports do not require that you specify a building or building group. In this case, the Select Building/Group dialog box does not appear.

5. Click on the building or building group you wish to include in the report.
   To include all the buildings or building groups listed, click on the All button.

6. Click on the OK button.
   The Preview window appears and displays the first page of the selected report.
**CENTRAL CLINIC**

**Description:** Dover Passenger, Serving Floors 1-6
**Car Size:** 80" x 60"  **Capacity:** 2,000
**Design Speed:** 350  **Machine Type:** Geared
**Maintenance Contractor:** Schindler Elevator Company  **Hoistway Structure:** Poured Concrete

**OPERATING CONDITIONS**
**Speed ULD (E.C.):** 330 / 240  **Leveling:** OK
**One-Floor/Flue ULD:** 6.7 / 6.4  **Nudging:** LRO0 ± 3" ± 3"

<table>
<thead>
<tr>
<th>Project #</th>
<th>Comp.Cd</th>
<th>Liability</th>
<th>Pri.Cls</th>
<th>ProjCls</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>00VT033</td>
<td>H-04</td>
<td>C</td>
<td>1</td>
<td>Deferred Maintenance</td>
<td>Replace missing fire tab gb at 4th floor</td>
</tr>
<tr>
<td>00VT030</td>
<td>M-10</td>
<td>C</td>
<td>1</td>
<td>Deferred Maintenance</td>
<td>Governor activation rope is slack - adjust</td>
</tr>
<tr>
<td>00VT034</td>
<td>H-10</td>
<td>C</td>
<td>2</td>
<td>Deferred Maintenance</td>
<td>Adjust all cable rope terminations (POCV = 3.5&quot;)</td>
</tr>
<tr>
<td>00VT029</td>
<td>M-01</td>
<td>C</td>
<td>2</td>
<td>Deferred Maintenance</td>
<td>Machine resetal and cleaning</td>
</tr>
<tr>
<td>00VT024</td>
<td>M-04</td>
<td>C</td>
<td>2</td>
<td>Deferred Maintenance</td>
<td>Replace brake shoes</td>
</tr>
<tr>
<td>00VT032</td>
<td>M-17</td>
<td>C</td>
<td>3</td>
<td>Deferred Maintenance</td>
<td>Clean floor of all carbon dust</td>
</tr>
</tbody>
</table>
Print One or More Reports

To print one or more reports:
1. Select the type of report you wish to create.
   The Report Selection window appears and lists the reports available for the type selected.

   1. Click on the name of each report you wish to create.
      The report name is highlighted. To deselect a report, click on the report name again.

   ![Report Selection Window]

   To create all the reports listed, click on the Select All check box. All the report names are highlighted.

2. To include the current date on the report(s), click on the Print Date check box.

3. To send the report(s) directly to the printer, click on the Print Button.

   The Select Building/Group dialog box appears and lists the buildings in Building Code order.
   To list the buildings by name, click on the Sort By: Building Name radio button.

   To list the building groups, click on the Groups radio button. To list the Groups by name,
   click on the Sort By: Group Name radio button.
Note: Depending on the specified report(s), the Select Building/Group dialog box may allow you to list both buildings and building groups, or buildings only, or building groups only. Also, some reports do not require that you specify a building or building group. In this case, the Select Building/Group dialog box does not appear.

4. Click on the building or building group you wish to include in the report. Click on the All button to include all the buildings or building groups listed.

The Printing information box indicates the printing status of each selected report.
Preview Window

The toolbar at the bottom of the Preview window provides the following functions and information (from left to right):

1. Click on the Beginning of Document button to move to the first page of the report.  
   If the report consists of only one page or if you are on the first page of the report, this  
   function is disabled. On the keyboard, press Ctrl + Home.

2. Click on the Previous Page button to move to the previous page of the report.  
   If the report consists of only one page or if you are on the first page of the report, this  
   function is disabled. On the keyboard, press Ctrl + Page Down.

3. The page counter indicates which page of the report is currently displayed and how many  
   pages the report contains.

4. Click on the Next Page button to move to the next page of the report.  
   If the report consists of only one page or if you are on the last page of the report, this  

5. Click on the End of Document button to move to the last page of the report.  
   If the report consists of only one page or if you are on the last page of the report, this  
   function is disabled. On the keyboard, press Ctrl + End.

6. Click on the Cancel button to cancel the creation of the report.  
   You should use this function only when creating the report is taking too much time.

7. Click on the Zoom icon to change the magnification of the report in the Preview window.  
   The magnification choices are:
   
   Enhanced: Largest magnification for easiest reading.
   Actual: Print size of page.
   Full: Full page reduced to fit within Preview window

8. Click on the Print icon to send the report to the printer.  
   The Print dialog box appears.  
   Select the Print Range and number of Copies and click on the OK button.  
   The Printing Preview information box appears indicating the print status.

9. Click on the Export icon to save the report as a disk file.  
   You will be prompted to determine several file formatting features and to specify the  
   destination filename and path.
10. Click on the Mail icon to send the report to an e-mail destination. You will be prompted to determine several file formatting features and to specify the e-mail destination address.

11. Click on the Close button to exit the Preview window for the current report.
Reports/Graphs

This function allows you to create, view, and print System Code, Priority Class, and Project Classification graphs for a specified building.

Note: You can create a graph report regardless of your security level.

To create graphs for a specified building:

1. Select Graphs from the Reports menu.
   The Select Building dialog box appears and lists the buildings included in the FCA database.
   To list the buildings by name, click on the Sort By: Building Name radio button.

   ![Select Building Dialog Box]

2. Select the building for which you wish to create graphs.
   The Graphs window appears and displays the System Code graph for the building selected.
To display the Priority Class graph for the building, click on the Priority Class radio button. To display the Project Classification graph for the building, click on the Project Classification radio button.

To print the currently displayed graph using the Portrait paper orientation, click on the Portrait radio button.

To send the currently displayed graph to the FCA System printer, click on the Print button.

To copy the currently displayed graph to the Windows clipboard, click on the Copy button.

3. Click on the Close button to exit the Graphs window.
Reports/Custom

This function allows you access all FCA System reports including those that have not yet been assigned to a selected report list.

Reports that are available but not part of a select report list were not part of FCA documents. The Customize function of the Utility menu is used to add reports to select report lists.

The procedures for creating, viewing, and printing reports are generally the same for all reports.

Note: You can access a custom report regardless of your security level.

To access a report using the Custom function:

1. Select Custom from the Reports menu.
   The Select Custom Report dialog box appears and lists all FCA System reports.

   ![Select Custom Report](image)

   To access reports in a different directory, locate the directory using the Available Directories browse feature. All reports should be in the default directory.

2. Select the report name from the list of report file names.
   A dialog box may prompt you to indicate whether the report is to be run by building.
3. To run the report by building, click on the Yes button. Any reports involving one or more buildings must be run per building.

Reports that include no building-specific data cannot be run per building. Examples include the Category Code report, the Labor Code report, or any other system data report.

If you choose Yes, the Select Building/Group dialog box appears and lists the buildings in Building Code order. To list the buildings by name, click on the Sort By: Building Name radio button.

To list the building groups, click on the Groups radio button. To list the Groups by name, click on the Sort By: Group Name radio button.

Note: Depending on the specified report, the Select Building/Group dialog box may allow you to list both buildings and building groups, or buildings only, or building groups only.

4. Click on the building or building group you wish to include in the report.
5. Click on the OK button.
The Preview window appears and displays the first page of the selected report.

<table>
<thead>
<tr>
<th>Bid Code</th>
<th>Building Name</th>
<th>Total Project Costs</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>CENTRAL CLINIC</td>
<td>$6,992,079</td>
</tr>
</tbody>
</table>

Grand Total: $6,992,079